FileMaker PRO 4.0
Installation and New Features Guide

Claris Corporation
5201 Patrick Henry Drive
Santa Clara, California 95054
http://www.claris.com

Claris, ClarisWorks, and FileMaker are trademarks of Claris Corporation, registered in the U.S. and other
countries, and Claris Home Page is a trademark of Claris Corporation.
Apple, AppleScript, AppleShare, AppleTalk, HyperCard, LocalTalk, Mac, Macintosh, MacTCP,
PowerBook, Power Macintosh, and QuickTime are trademarks of Apple Computer, Inc., registered in the
U.S. and other countries. Finder is a trademark of Apple Computer, Inc. All other trademarks are the property
of their respective owners.

This software is based in part on the work of the Independent JPEG group.
Portions of the software are © 1992-1996 Novell, Inc. All Rights Reserved.
Mention of third party companies and products is for informational purposes only and constitutes neither an
endorsement nor a recommendation.
All persons and companies listed in the examples are purely fictitious and any resemblance to existing
persons and companies is purely coincidental.
Contents

Chapter 1: Installing FileMaker Pro
About this guide 1-1
Registration and customer support 1-1
What you need to install FileMaker Pro 1-2
  Minimum hardware and software requirements 1-2
  Networking requirements 1-3
  Web publishing requirements 1-3
  Requirements for advanced features 1-4
Before you begin 1-4
Installing FileMaker Pro 1-4
  Starting the Installer 1-4
  Easy installation 1-5
  Custom installation 1-7
Updating your User Dictionary 1-9
Where files are stored on your hard disk 1-9
  FileMaker Pro 4.0 Folder 1-10
  System Folder 1-12
Adjusting memory 1-13
  Changing the amount of memory used 1-13
Choosing a network protocol 1-14
Opening files from previous versions 1-15
Where to go from here 1-16

Chapter 2: New features in FileMaker Pro
Web publishing capabilities 2-1
  Instant Web Publishing 2-1
  Custom Web Publishing 2-2
New Internet features 2-2
  GIF and JPEG support 2-2
  Export to an HTML table 2-2
  Send Mail script step 2-2
  URL support 2-2
  Open URL script step 2-2
Expanded Sort and Find options 2-3
New calculation functions 2-3
Layout and interface enhancements 2-3
Excel import 2-3
Appendix A: MacIPX control panel

Using an Ethernet or token-ring network interface for MacIPX A-1
  Selecting a frame type A-2
Using an AppleTalk interface for MacIPX A-4
Setting advanced MacIPX parameters A-6
Chapter 1: Installing FileMaker Pro

Welcome to the FileMaker Pro application from Claris Corporation. FileMaker Pro is designed to help you manage information easily and effectively.

About this guide

This FileMaker Pro Installation and New Features Guide includes instructions for installing the application on your hard disk.

- Chapter 1, “Installing FileMaker Pro,” gives instructions for installing the application, registering your ownership, and everything else you need to do before you can use FileMaker Pro.
- Chapter 2, “New features in FileMaker Pro,” provides an overview of the new features in FileMaker Pro 4.0. This chapter is especially helpful for users upgrading from previous versions of FileMaker Pro.
- Appendix A, “Setting up the MacIPX control panel,” provides information on using MacIPX for networking.

This installation guide, the FileMaker Pro User’s Guide, and the onscreen Help system work together to give you the information you need to know as you learn about FileMaker Pro.

Registration and customer support

Please take the time to complete and mail the product registration card that is included in this package. Refer to our Web site at http://www.claris.com for information about customer support.

U.S. and Canadian retail customers can also refer to the Claris Service Directory included with the software. For customers outside of the U.S. or Canada, refer to the Technical Support brochure included with the software.
What you need to install FileMaker Pro

This guide gives instructions for installing the FileMaker Pro application and associated files on your Mac OS computer. Before you begin installing, you must know how you plan to use FileMaker Pro.

- On a stand-alone computer—you want to use FileMaker Pro on your computer, and you don’t plan to share files with other users over a network.
- With networking—you want to use FileMaker Pro on your computer, and you plan to share FileMaker Pro files with other computers using either TCP/IP, AppleTalk, or IPX/SPX networking software.

If you’re on a network You need to know which type of network you’re using. If you’re not sure which network option to choose, check with your network administrator before you begin installation.

Minimum hardware and software requirements

To install and use FileMaker Pro, you need the CD-ROM disc in the FileMaker Pro package and the following minimum equipment and software:

- a Macintosh or Mac OS computer with at least 4 MB of RAM (8 MB is required for running FileMaker Pro Web Companion). For Power Macintosh and compatible computers, 8 MB of RAM is required.
- a hard disk
- a CD-ROM drive
- System 7.1 or later, or Mac OS 8

You also need your FileMaker Pro Installation Code to install and run the application. Look for it in the product package.

Memory settings To see the minimum and preferred application memory settings for FileMaker Pro, select the FileMaker Pro application icon after installation and choose Get Info from the File menu. For information about adjusting the memory allocated to FileMaker Pro, see “Adjusting memory” on page 1-13.
Networking requirements

To share files among users on a network, you can use TCP/IP, IPX/SPX, or AppleTalk networking software. You can use one of the following solutions to share files on a mixed Mac OS and PC network.

<table>
<thead>
<tr>
<th>TCP/IP</th>
<th>Mac OS</th>
<th>Windows 95</th>
<th>Windows NT</th>
<th>Windows for Workgroups</th>
<th>Windows 3.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>(recommended)</td>
<td>MacTCP 2.0.6 or later or Open Transport 1.1 or later</td>
<td>Microsoft TCP/IP</td>
<td>Microsoft TCP/IP</td>
<td>MicrosoftTCP/IP-32 version 3.11b</td>
<td>Network</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>TeleSystems TCP Pro 3.0 or later</td>
</tr>
<tr>
<td>IPX/SPX</td>
<td>MacIPX version 1.3.1</td>
<td>IPX/SPX</td>
<td>Microsoft NWLink IPX/SPX Compatible Transport</td>
<td>Novell NetWare Client Software Shell version 3.26 or later</td>
<td>Novell NetWare Client Software Shell version 3.26 or later</td>
</tr>
</tbody>
</table>

For more information about MacIPX, see appendix A, “MacIPX control panel.” For information about other networking protocols, see the documentation that came with your Mac OS computer or network software.

Using MacIPX with AppleTalk When you choose MacIPX for networking, you can still access your AppleTalk printers and AppleShare servers. MacIPX is used for networking FileMaker Pro files only.

If you are using a 68000 Macintosh computer, such as a Macintosh Plus, Macintosh SE, Macintosh Portable, or PowerBook 100, you should use only the AppleTalk protocol. MacIPX and MacTCP have only limited support on these computers.

Web publishing requirements

To publish a database on the Web using the FileMaker Pro Web Companion, you need a host computer with access to the Internet or an intranet via TCP/IP. The host computer must be either a Mac OS computer or a PC running Windows 95 or Windows NT 3.5 or later.

Note Web publishing in FileMaker 4.0 is not supported under Windows 3.1 or Windows for Workgroups.

**Important** Access to the Internet requires an Internet service provider. FileMaker Pro does not provide an Internet account for you.
Requirements for advanced features

Some of the advanced features of FileMaker Pro 4.0 require additional software.

<table>
<thead>
<tr>
<th>FileMaker Pro 4.0 advanced feature</th>
<th>Software requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL support</td>
<td>Internet Config 1.1 or later</td>
</tr>
<tr>
<td>Open URL script step</td>
<td>Internet Config 1.1 or later</td>
</tr>
<tr>
<td>Send Mail script step</td>
<td>Internet Config 1.1 or later and email client software</td>
</tr>
<tr>
<td>Send Apple event script step</td>
<td>AppleScript system software</td>
</tr>
<tr>
<td>Custom Web Publishing</td>
<td>An HTML editing application, such as Claris Home Page 3.0 software. Web browser software is suggested to view your work.</td>
</tr>
</tbody>
</table>

AppleScript is installed with a normal System software installation. The Internet Config application and extension are installed with some versions of System software. If you don’t have this software, refer to our Web site at http://www.claris.com for further information.

Before you begin

Before you begin the installation process, turn off virus protection and file sharing.

Virus protection utilities and personal file sharing can interfere with the operation of the FileMaker Pro Installer. Before you install FileMaker Pro, disable these utilities and turn off file sharing.

Installing FileMaker Pro

You must use the installation program to install FileMaker Pro—you can’t install the application by dragging files to your hard disk.

Starting the Installer

To start the FileMaker Pro Installer:

1. Disable virus protection and file sharing if you haven’t already.

2. Insert the CD-ROM disc into your CD-ROM drive.

You see the disc’s window on your screen. If you see only the disc icon, double-click the icon to open its window.
3. Double-click the file named **Start Here**.
   You see the software license agreement.

4. Click **Accept** to accept the license agreement.
   You see the FileMaker Pro Installer dialog box.

5. Follow the steps described in one of the following sections:
   - If you want to install all the available files, continue with “Easy installation.”
   - If you want to install a subset of the FileMaker Pro files, skip to “Custom installation” on page 1-7.

### Easy installation

Follow these steps to install the complete FileMaker Pro package on your hard disk. The Installer automatically installs the correct version for either 680x0 Macintosh computers or Power Macintosh and compatible computers.

**Important** To install a subset of FileMaker Pro files, see “Custom installation” on page 1-7.

To install FileMaker Pro on your hard disk:

1. If you have not already done so, start the Installer.
   You see the FileMaker Pro Installer dialog box.

2. Specify the installation location, or use the default location.
If you don’t see the name of the hard disk where you want to install FileMaker Pro, click the **Switch Disk** button, which appears only when you have more than one volume mounted.

If you switch to a disk that isn’t a hard disk or is locked, the **Install** button is dimmed and the dialog box tells you why you can’t install onto that disk.

If the selected disk doesn’t have enough space for the files you select, you see a message. If you switch to the Finder software, you can delete existing files to make more room on the disk. You can also choose not to install some files (like the tutorial or template files) by selecting **Custom Install** from the pop-up menu. For more information, see “Custom installation” on page 1-7.

To select the folder in which you want to install the FileMaker Pro 4.0 Folder, choose **Select Folder** from the pop-up menu and select the desired folder.

3. Click **Install**.
   You see the Personalize dialog box.

4. In the **Name** box, type your name and press the Tab key.
5. Type your company name, if applicable, and press Tab.
   If you don’t have a company name, you can put other information (like your address) in the box or leave it blank.
6. Type your FileMaker Pro Installation Code.
The Installation Code number is not optional. Look for your Installation Code in the product package.

Check your typing carefully. After you click OK you can’t change the name, company, or Installation Code number unless you re-install FileMaker Pro.

7. Click OK
The Installer begins copying files. A dialog box tells you what the Installer is doing.

After all the files are installed, a final dialog box tells you the installation on your hard disk was successful.

8. If you are installing the MacIPX networking software, click Continue. (You must do a Custom Installation to install MacIPX. See the next section, “Custom installation.”) Otherwise, click Quit to leave the Installer.

9. If you turned off virus protection and file sharing before installing, remember to turn them back on now.

Custom installation

To install a subset of FileMaker Pro files on your hard disk:

1. If you have not done so already, start the Installer.
   To do so, use the steps described in “Starting the Installer” on page 1-4.
   You see the FileMaker Pro Installer dialog box.

2. Choose Custom Install from the pop-up menu.
   The dialog box lists the files you can install.
3. Select the files you want to install by clicking the checkboxes.

4. Specify the installation location, or use the default location.
   - If you don’t see the name of the hard disk where you want to install FileMaker Pro, click the Switch Disk button, which appears only when you have more than one volume mounted.
   - If you switch to a disk that isn’t a hard disk or is locked, the Install button is dimmed and the dialog box tells you why you can’t install onto that disk.
   - If the selected disk doesn’t have enough space for the files you select, you see a message. In the Finder software, you can delete existing files to make more room on the disk. You can also choose not to install some files (like the tutorial or template files) by deselecting those files in the scrolling list.
   - To select the folder in which you want to install the FileMaker Pro 4.0 Folder or the specified files, choose Select Folder from the pop-up menu and select the desired folder.

5. Click Install.
   If you’ve selected the application, you see the Personalize dialog box.

6. In the Name box, type your name and press the Tab key.

7. Type your company name, if applicable, and press Tab.
   If you don’t have a company name, you can put other information (like your address) in the box or leave it blank.

8. Type your FileMaker Pro Installation Code.
The Installation Code number is not optional. Look for your Installation Code card in the product package.

Check your typing carefully. After you click **OK** you can’t change the name, company, or Installation Code number unless you re-install FileMaker Pro.

**9. Click OK**

The Installer begins copying files. A dialog box tells you what the Installer is doing.

After the selected files are installed, a final dialog box tells you the installation on your hard disk was successful.

**10. Click Quit to leave the Installer.**

If you installed the MacIPX networking software, the final dialog box allows you to restart your computer. You must restart your computer before you can use the new network software.

**11. If you turned off virus protection and file sharing before installing, remember to turn them back on now.**

**Updating your User Dictionary**

If you have added words to your User Dictionary in either a previous version of FileMaker Pro or another Claris product, then you must export that User Dictionary to a text file, then import it into FileMaker Pro 4.0.

1. **Export your User Dictionary using your other Claris product.**
2. **In FileMaker Pro 4.0, choose Spelling from the Edit menu, then choose Edit User Dictionary.**
3. **Click the triangle next to Text File to show the Import and Export buttons.**
4. **Click Import and import the text file containing the words from your previous User Dictionary.**

**Where files are stored on your hard disk**

The following table shows the files and folders you can install, and the preferred location for them on your hard disk. If you install onto the current system disk, the FileMaker Pro Installer places all the files you need in their preferred locations.
### FileMaker Pro 4.0 Folder

This table shows the files and folders installed in the FileMaker Pro Folder.

<table>
<thead>
<tr>
<th>FileMaker Pro 4.0 Folder</th>
<th>File or folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileMaker Pro Folder</td>
<td>FileMaker Pro</td>
<td>The FileMaker Pro 4.0 application</td>
</tr>
<tr>
<td></td>
<td>FileMaker Pro Help</td>
<td>The FileMaker Pro onscreen Help system</td>
</tr>
<tr>
<td></td>
<td>FileMaker Pro Balloon Help</td>
<td>The FileMaker Pro onscreen Balloon Help system</td>
</tr>
<tr>
<td></td>
<td>Read Me</td>
<td>Late breaking news about FileMaker Pro</td>
</tr>
</tbody>
</table>

| FileMaker Tutorial folder | FileMaker tutorial | A FileMaker Pro file that introduces you to the main features of FileMaker Pro 4.0 |

| FileMaker Templates folder | Template files | Predesigned template files that help you use FileMaker Pro right away |

| FileMaker Examples folder | Example files | Example databases that show you the advanced features of FileMaker Pro. These are predesigned sample files with data. |

| FileMaker and Apple Events folder | Apple Events Reference | A FileMaker database that documents how to use Apple events with FileMaker Pro. |

| Sample Applications folder | Folders containing scripting examples, sample AppleScript, and HyperCard applications. |

| Syntax Examples folder | |

| FileMaker Extensions folder | AppleTalk Network | Modules that support AppleTalk, MacIPX, and TCP/IP networks |
| MacIPX Network | TCP/IP Network |

| ClarisWorks Database | DBF | Filters for translating ClarisWorks database, DBF, and Microsoft Excel files |
| Excel |

| Web Companion | The Web Companion plug-in that enables Web publishing from FileMaker Pro |

<table>
<thead>
<tr>
<th>Web folder (for Web Publishing, do not move or rename this folder)</th>
<th>Employee Database files</th>
<th>Example databases and HTML files that you can use to learn about Custom Web Publishing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Guest Book files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shopping Cart files</td>
<td></td>
</tr>
<tr>
<td><strong>Folder</strong></td>
<td><strong>File or folder</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Web Tools folder</td>
<td>CDML Reference</td>
<td>For Custom Web Publishing, a FileMaker database that documents how to use the Claris Dynamic Markup Language (CDML) to create dynamic HTML files; contains a <em>Developer’s Guide</em>.</td>
</tr>
<tr>
<td>CDML Tool</td>
<td></td>
<td>For Custom Web Publishing, a FileMaker database that helps you create HTML format files that contain CDML tags, using Copy and Paste.</td>
</tr>
<tr>
<td>CDML Template folder</td>
<td></td>
<td>For Custom Web Publishing, HTML files containing CDML tags for standard actions (Add Record, Search, and so on) to be used as building blocks for your Custom Web Publishing files.</td>
</tr>
<tr>
<td>Web Security folder</td>
<td>Databases folder</td>
<td>A folder containing the FileMaker databases required to use with Web Security safeguards.</td>
</tr>
<tr>
<td>Security folder</td>
<td></td>
<td>HTML files used for remote administration of the Web Security databases. Move to the Web folder when in use.</td>
</tr>
</tbody>
</table>
## System Folder

This table shows the files and folders placed in your System Folder.

<table>
<thead>
<tr>
<th>System Folder</th>
<th>File or folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Claris folder</td>
<td>FileMaker Help Viewer</td>
<td>The application that accesses the FileMaker Pro Help file</td>
</tr>
<tr>
<td></td>
<td>USENGLSH.MPR</td>
<td>The primary dictionaries that FileMaker Pro uses to spell check your files. You can select either U.S. or British spellings for your main dictionary. Each dictionary contains over 100,000 words.</td>
</tr>
<tr>
<td></td>
<td>UKENGLSH.MPR</td>
<td>The primary dictionaries that FileMaker Pro uses to spell check your files. You can select either U.S. or British spellings for your main dictionary. Each dictionary contains over 100,000 words.</td>
</tr>
<tr>
<td></td>
<td>USER.UPR</td>
<td>The dictionary that stores your customized list of spelling exceptions and additions to the primary dictionaries</td>
</tr>
<tr>
<td></td>
<td>CLADDON.CLR</td>
<td>An additional dictionary that contains computer terminology</td>
</tr>
<tr>
<td>Claris Translators folder</td>
<td>Translators that FileMaker Pro uses to read graphics files created in other applications</td>
<td></td>
</tr>
<tr>
<td>Claris XTND System</td>
<td>Translation engine</td>
<td></td>
</tr>
<tr>
<td>Control Panels folder</td>
<td>MacIPX control panel</td>
<td>Control panel for configuring MacIPX. This file is installed only in a Custom installation.</td>
</tr>
<tr>
<td>Extensions folder</td>
<td>MacIPX AppleTalk</td>
<td>MacIPX interface files. These files are installed only in a Custom installation.</td>
</tr>
<tr>
<td></td>
<td>MacIPX Ethernet</td>
<td>MacIPX interface files. These files are installed only in a Custom installation.</td>
</tr>
<tr>
<td></td>
<td>MacIPX Token Ring</td>
<td>MacIPX interface files. These files are installed only in a Custom installation.</td>
</tr>
<tr>
<td>XTND Power Enabler (Power Macintosh and compatible computers only)</td>
<td>Extension that enhances the XTND graphics importing capabilities of Claris products on these computers</td>
<td></td>
</tr>
<tr>
<td>Microsoft OLE Extension</td>
<td>Extension that is necessary for Excel 5.0 import</td>
<td></td>
</tr>
</tbody>
</table>
Adjusting memory

The Mac OS sets aside a certain amount of memory for FileMaker Pro. However, you might need to change the amount of memory reserved for FileMaker Pro if you plan to:

- work on a large database file
- work on several database files at once
- host database files
- use a database file that contains many graphics
- insert a large graphic into a database file
- run several applications at the same time, and you have a limited amount of memory (RAM) installed

For detailed information on managing memory, see the documentation that came with your Mac OS computer.

Changing the amount of memory used

If you want to change the amount of memory reserved for FileMaker Pro, keep the following points in mind:

- The amount of memory you give to FileMaker Pro affects your ability to run other applications. If the Mac OS and FileMaker Pro take up all the available memory, you won’t be able to open other applications.
- Avoid specifying less memory than the Suggested size in the FileMaker Pro Info dialog box.

To change the amount of memory FileMaker Pro uses:

1. If FileMaker Pro is open, quit the application by choosing Quit from the File menu.

2. In the Finder software, open the FileMaker Pro 4.0 Folder and click the FileMaker Pro application icon.

   Note: If you click the application icon twice, you will start FileMaker Pro. If that happens, choose Quit from the File menu and try again.
3. Choose Get Info from the File menu.
   You see the FileMaker Pro Info window.

![FileMaker Pro Info](image)

4. In the Memory Requirements area at the bottom of the window, double-click thePreferred size number and type a number to change the memory allocated for FileMaker Pro.
   If you can’t type in the box, make sure you’ve quit FileMaker Pro.

5. Click the close box.
   The next time you start FileMaker Pro, the amount of memory you specified is available for the application.

### Choosing a network protocol

You must choose a network protocol if you want to use FileMaker Pro over a network, either as a guest or as a host. For more information about your network, consult your network administrator.

**Important** The network protocol setting in FileMaker Pro must be the same on the host and all guest computers.
To choose a network protocol:

1. Choose **Preferences** from the Edit menu, and then choose **Application**.
   You see the Application Preferences dialog box. If necessary, choose **General** from the pop-up menu at the top of the dialog box.

2. Choose a network protocol from the Network protocol pop-up menu.

3. Click **Done**.
   Changes to this setting don’t take effect until you quit FileMaker Pro and then start it again.

---

**Opening files from previous versions**

FileMaker Pro 4.0 can open files from all versions of FileMaker Pro for the Mac OS and from FileMaker Pro 2.x, 3.x, and 4.0 for Windows. To use files created with FileMaker Pro 1.x or 2.x, you must convert them to FileMaker Pro 4.0.

**Important** You do not need to convert 3.x files. In FileMaker Pro 4.0, you can open files created with FileMaker Pro 3.x; in FileMaker 3.x, you can open files created with FileMaker Pro 4.0. However, new 4.0 features aren’t supported when you open files in 3.x. For example, rotated fields will appear as horizontal (left to right) fields in 3.x.

To convert and open a file:

1. Start FileMaker Pro 4.0.
2. Choose Open from the File menu and select the file you want in the Open dialog box. You can also drag and drop a group of files onto the FileMaker Pro 4.0 icon.

You see the Conversion dialog box.

3. Type a name to rename the original file, or deselect the Rename old file as checkbox to retain the name of the file.

If you use the default settings, the original file remains in the older format.

4. Click OK

You see another dialog box where you can name the file that will be created and saved in the new format. You cannot use the converted file with versions of FileMaker Pro earlier than 3.0.

5. Click Save to start the conversion.

FileMaker Pro converts the file and opens it.

Where to go from here

After you install FileMaker Pro, you can immediately begin working with the application. Here are some suggestions on where to go in the documentation to get started:

- If you’re new to databases, read chapter 1, “FileMaker Pro basics,” in the FileMaker Pro User’s Guide to learn basic database concepts.
- If you’re new to FileMaker Pro, work through the online tutorial, which is automatically installed when you do an Easy Install.
- If you’ve used FileMaker Pro before, read chapter 2 of this guide to find out about the new features available in FileMaker Pro 4.0.
Chapter 2: New features in FileMaker Pro

This chapter introduces the new features available in FileMaker Pro 4.0.

Web publishing capabilities

Using FileMaker Pro 4.0, you can access your database from almost anywhere in the world. Your file can be viewed, edited, sorted, and searched with just Web browser software and access to the Internet or your intranet. You can also choose how much or how little access users have to your file.

Note: Access to the Internet requires an Internet service provider. FileMaker Pro does not provide an Internet account for you.

Instant Web Publishing

With FileMaker Pro 4.0, you can quickly publish your database on the Internet or on an intranet, using the FileMaker Pro Web Companion.

This functionality is built in—no additional CGI or Web server software is required for either the Mac OS, Windows 95, or Windows NT. However, access to the Internet requires an Internet account.
Custom Web Publishing

You can create a complete, custom, interactive Web solution using FileMaker Pro 4.0 Web Companion and dynamic HTML files. FileMaker Pro now can publish HTML documents containing GIF and JPEG graphics, animated GIF files, QuickTime movies, AIFF files, or Java applets.


New Internet features

Note Some of these features require additional software. See “Requirements for advanced features” on page 1-4.

GIF and JPEG support

FileMaker Pro 4.0 supports GIF and JPEG graphic formats in layouts, container fields, and published Web pages. When FileMaker Pro sends an image to a Web browser, it can send either a GIF or JPEG image. If one is not available, the stored graphic is converted on-the-fly to JPEG for display, even if it is not stored in JPEG format in the database.

Export to an HTML table

You can now export all or part of your database formatted as an HTML table.

Send Mail script step

With email client software, you can send email via the Internet or your intranet directly from your FileMaker Pro database.

URL support

When you Command-click a URL in a field, FileMaker Pro opens that URL. If the address is for a Web page, FileMaker Pro opens your Web browser software.

Open URL script step

You can write a script that opens a URL.
Expanded Sort and Find options

Related records can now be sorted within a portal or as part of a related list.

With the addition of exact field matches, Find requests can be even more specific.

New calculation functions

New functions help you determine:
- the current group that a password belongs to
- the modifier key being pressed by the user
- the network protocol that is loaded and in use
- the ID of the current record
- the number and kinds of objects in a layout

Layout and interface enhancements

Fields and objects can be now rotated in 90-degree increments, allowing greater flexibility in your layouts. Text can also be dragged and dropped into a rotated text block. You can zoom in or out on a rotated object.

To make creating and managing your files easier, value lists can now be defined from the File menu. Recently opened documents are now listed in the File menu on both the Mac OS and Windows platforms. You can turn this feature on or off in Application Preferences.

Excel import

FileMaker Pro now supports direct import of worksheets (.XLS files) from Microsoft Excel, including version 4.0 and 5.0 for Mac OS, and versions 4.0 through Excel 97 for Windows. Additionally, you can import a specific worksheet from an Excel workbook.


Appendix A: MacIPX control panel

You can use the MacIPX control panel to:
- select the network interface for your applications which use MacIPX
- change parameters that MacIPX uses (if necessary)

**Important** For enhanced performance, TCP/IP is recommended.

**Using an Ethernet or token-ring network interface for MacIPX**

The MacIPX control panel displays icons for the available network interfaces, such as Ethernet, AppleTalk, and token ring. MacIPX automatically configures itself for the first networking environment it detects when the Macintosh starts.

**AppleTalk users** For information on selecting an AppleTalk interface and related options, see “Using an AppleTalk interface for MacIPX” on page A-4.

**PCI Power Macintosh computer users (such as 4400, 7200, 7500, 8500, 9500 or later and other Mac OS computers)** These Mac OS models use Open Transport networking.

**Warning** Be sure to use Open Transport version 1.1 or later.

To switch between network interfaces (Ethernet, Token Ring, or AppleTalk):
1. Open the MacIPX control panel.
2. Click one of the icons to select it.

The software on your computer system determines which icons you see.

3. Click OK and then close the MacIPX dialog box.

**Note** MacIPX 1.3.1 supports most Ethernet interface cards, as well as the token-ring interface card from Apple Computer.

**Selecting a frame type**

A frame encapsulates packets of information in a recognizable format. Each packet on the network must conform to a specific frame type to successfully communicate with other computers on the network. After you select the network protocol, you must select a frame type.

**Note** All computers communicating with each other on the network must use the same frame type. If you have questions about your frame type, check with your network administrator.
To have MacIPX select the frame type:

1. In the MacIPX control panel, double-click the selected network interface icon.

   You see the Access Configuration dialog box for your chosen network interface. For example, if you click the Ethernet icon, you see the Ethernet Access Configuration dialog box, where you can set parameters for working with Ethernet.

2. In the Access Configuration dialog box, click **Always Auto-Configure Frame Type**.

3. Click **OK** to close the dialog box.

   When you start up your computer, MacIPX determines the appropriate frame type by monitoring packets on the network. When this option is checked, the buttons for the frame types are unavailable.

   **Note**  When IPX is using more than one frame type on a network, MacIPX might not choose the frame type you require. If, after configuring the MacIPX control panel, you are unable to connect to FileMaker Pro databases using the Network Access dialog box (or the files are not listed), you may have the wrong frame type selected for your network. Try turning off **Always Auto-Configure Frame Type** and then select the appropriate frame type. Consult your network administrator if you have questions.
To select a frame type manually:

1. In the Access Configuration dialog box, deselect Always Auto-Configure Frame Type.
2. Click the appropriate frame type, and then click OK.
   Check with your network administrator if you’re not sure which frame type to select.
   When you close the dialog box, you see an alert dialog box.
3. Click OK.

To have MacIPX determine the appropriate frame type at any moment:

1. In the Access Configuration dialog box, click Auto-Configure Frame Type Now. Then click OK to dismiss the message.
   In the dialog box, MacIPX highlights buttons in sequence until it determines the appropriate frame type.
2. Click OK to close the dialog box.

Using an AppleTalk interface for MacIPX

If your Mac OS computer is connected to an Apple LocalTalk network, you must specify an AppleTalk interface to use MacIPX networking. When you use AppleTalk, you must also select an IPX gateway.

Important Novell supplies MACIPXGW.LAN, a LAN driver (IPX gateway) that can be run on Novell NetWare v3.11 or later servers, which lets you use AppleTalk to share information with other computers on the IPX network. Contact your Novell dealer or use an online service to get this driver. To install the LAN driver on your Novell server, see your Novell system administrator or the documentation that came with the driver.

To select an AppleTalk network interface:

1. Open the MacIPX control panel.
   The MacIPX control panel is installed in the Control Panels folder inside the System Folder.
2. If necessary, click the AppleTalk icon to select it and then click the close box.
Your computer then sends IPX packets encapsulated in AppleTalk, which are delivered on the LocalTalk network to an IPX gateway. The gateway decapsulates these packets and routes them over an IPX network. See the following steps for information on selecting a gateway.

To have MacIPX select an available IPX gateway:
1. In the MacIPX control panel, click the selected AppleTalk icon.
   You see the AppleTalk Access Configuration dialog box.
2. In the AppleTalk Access Configuration dialog box, choose an AppleTalk zone that has an IPX gateway.
3. Click **Always Auto-Select an IPX Gateway from the Selected Zone**
4. Click **OK** to close the dialog box.
   When the computer starts up and detects that it’s connected to an AppleTalk networking interface, such as LocalTalk, it selects an appropriate IPX gateway in the specified zone. In some cases (for example, if you get an error message), you need to select the gateway yourself.

To select an IPX gateway yourself:
1. In the AppleTalk Access Configuration dialog box, deselect **Always Auto-Select an IPX Gateway from the Selected Zone**.
2. Choose an AppleTalk zone where an IPX gateway is installed. When you click a zone name, you see a list of available IPX gateways.

3. Click an IPX gateway.

4. Click OK to close the dialog box.

**Setting advanced MacIPX parameters**

From the MacIPX control panel, you can set other parameters that affect MacIPX operations.

*Important* Only a certified network engineer or administrator should change the advanced parameters. Changing the parameters without a good understanding of their functions can adversely affect the performance of MacIPX. For more information, see your network administrator or contact your Novell dealer.

To set advanced parameters:

1. In the MacIPX control panel, click *Advanced Options*.

   You see the MacIPX Parameters dialog box.
2. Set the parameters you want and click OK to save your changes. You must restart your computer for the changes to take effect.

**Note** To restore the parameters to the default settings provided by Novell, click Restore Defaults and restart your system. If you make changes to the settings and want to restore the parameters to what they were when you opened the dialog box, click Cancel.

Use the information in the following tables to set parameters for:
- MacIPX
- SPX (Sequenced Packet Exchange)
- SAP (Service Advertising Protocol)
- RIP (Routing Information Protocol)

<table>
<thead>
<tr>
<th>MacIPX parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable IPX Diagnostic Services</td>
<td>Disables the IPX Diagnostic Services, used by some network management tools. Disabling IPX Diagnostic Services can reduce the amount of memory that MacIPX uses. Click this parameter if you don’t use any network management tools, or if your tool doesn’t use IPX Diagnostic Services.</td>
</tr>
<tr>
<td>Maximum Network Packet Size</td>
<td>Limits the maximum network packet size. The value can’t be greater than the maximum value supported by the physical network. Enter 0 (zero) to let MacIPX determine for itself what value to use.</td>
</tr>
<tr>
<td>Enable IPX Checksumming</td>
<td>Enables checksumming of IPX packets. The option is unavailable if the current network doesn’t support IPX checksumming.</td>
</tr>
</tbody>
</table>

For the following SPX parameters, you can enter any value between 0 and 9999. The values for Abort Timeout, Listen Timeout, and Verify Timeout apply only to those SPX connections using the “watchdog,” such as those used by FileMaker Pro 4.0.

<table>
<thead>
<tr>
<th>SPX parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abort Timeout</td>
<td>Sets the amount of time that SPX waits, without receiving any response from the other side of the connection, before it terminates the session. The timeout number is expressed in ticks (with 60 ticks per second). The default value is 2400 ticks, or 40 seconds.</td>
</tr>
</tbody>
</table>
For the following SAP parameters, you can enter any value between 0 and 9999, but an application can override the values you set.

<table>
<thead>
<tr>
<th>SAP parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Interval</td>
<td>Specifies the time that must elapse before an SAP query is retransmitted. The default value is 120 ticks, or 2 seconds.</td>
</tr>
<tr>
<td>Query Attempts</td>
<td>Specifies the number of times that an SAP query is transmitted. The default value is 3 times.</td>
</tr>
<tr>
<td>Receive Buffers</td>
<td>Specifies the number of buffers to handle responses returned from SAP queries. The default is 20 buffers.</td>
</tr>
</tbody>
</table>

For the following RIP parameter, you can enter any value between 0 and 9999.

<table>
<thead>
<tr>
<th>RIP parameter</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retry Interval</td>
<td>Specifies the time that must elapse before a RIP request is retransmitted. The default value is 0 ticks, which lets the MacIPX determine what the interval should be, based on the network configuration.</td>
</tr>
</tbody>
</table>